Abstract

This document describes removal and installation of field-replaceable units for Dot Hill AssuredSAN Ultra56 Series controller enclosures, and is intended for use by storage system administrators familiar with servers and computer networks, network administration, storage system installation and configuration, storage area network management, and relevant protocols.
# Contents

About this guide ................................................................. 7
   Overview ................................................................. 7
   AssuredSAN Ultra56 Series enclosure user interfaces ................. 7
   Intended audience ....................................................... 7
   Prerequisites ............................................................. 7
   Related documentation .................................................. 8
   Document conventions and symbols ..................................... 8

1 FRUs .............................................................................. 10
   Available FRUs ............................................................ 10
      Storage enclosure overview ........................................ 10
      FRUs addressing 56-drive enclosures ......................... 11
         Enclosure bezel attachment ..................................... 15
         Enclosure bezel removal ......................................... 15
         Enclosure bezel for 56-drive model .......................... 15
      Supported drive enclosures ........................................ 16

2 Procedures .................................................................... 17
   Electrostatic discharge .................................................. 17
      Preventing electrostatic discharge ............................... 17
      Grounding methods to prevent electrostatic discharge ....... 17
   Replacing chassis FRU components .................................... 18
   Replacing a controller module or expansion module ............... 19
      Before you begin ....................................................... 20
      Configuring partner firmware update ............................ 20
         Using the SMC or RAIdar ......................................... 20
         Using the CLI ......................................................... 21
      Verifying component failure ....................................... 21
      Stopping I/O ................................................................ 21
      Shutting down a controller module ............................... 22
         Using the SMC or RAIdar ......................................... 22
         Using the CLI ......................................................... 23
      Removing a controller module or expansion module ......... 24
      Installing a controller module or expansion module .......... 25
      Verifying component operation .................................... 26
         Using the SMC or RAIdar ......................................... 26
         Using the CLI ......................................................... 27
   Updating firmware ........................................................ 27
   Accessing a drawer ....................................................... 28
      Opening and closing a drawer ...................................... 28
   Replacing a disk drive module ........................................ 30
      FDE considerations .................................................... 30
      Before you begin ..................................................... 31
      Verifying component failure ....................................... 31
      Removing a disk drive module .................................... 31
      Installing a disk drive module ..................................... 32
      Determine if a disk is missing ...................................... 34
         Using the SMC or RAIdar ......................................... 34
         Using the CLI ......................................................... 34
      Verifying component operation .................................... 34
   Replacing a power supply module .................................... 35
      Before you begin ..................................................... 35
      Verifying component failure ....................................... 35
      Power supply units .................................................... 36
## A Drawer description

<table>
<thead>
<tr>
<th>Drawer configuration</th>
<th>56</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loading requirements</td>
<td>57</td>
</tr>
<tr>
<td>LED descriptions for drawer components</td>
<td>57</td>
</tr>
<tr>
<td>Drawer front panel LEDs</td>
<td>57</td>
</tr>
<tr>
<td>Disk LEDs</td>
<td>58</td>
</tr>
</tbody>
</table>

## Index

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC and DC PSUs</td>
<td>37</td>
</tr>
<tr>
<td>Removing a power supply unit</td>
<td>38</td>
</tr>
<tr>
<td>Installing a power supply unit</td>
<td>39</td>
</tr>
<tr>
<td>Connecting a power cable</td>
<td>40</td>
</tr>
<tr>
<td>Verifying component operation</td>
<td>41</td>
</tr>
<tr>
<td>Replacing a fan control module</td>
<td>41</td>
</tr>
<tr>
<td>Before you begin</td>
<td>41</td>
</tr>
<tr>
<td>Verifying component failure</td>
<td>42</td>
</tr>
<tr>
<td>Removing a fan control module</td>
<td>42</td>
</tr>
<tr>
<td>Installing a fan control module</td>
<td>43</td>
</tr>
<tr>
<td>Verifying component operation</td>
<td>44</td>
</tr>
<tr>
<td>Replacing ear components</td>
<td>45</td>
</tr>
<tr>
<td>Before you begin</td>
<td>45</td>
</tr>
<tr>
<td>Removing ear components</td>
<td>46</td>
</tr>
<tr>
<td>Installing ear kit components</td>
<td>46</td>
</tr>
<tr>
<td>Verifying component operation</td>
<td>47</td>
</tr>
<tr>
<td>Transceivers used in CNC ports</td>
<td>47</td>
</tr>
<tr>
<td>Replacing a Fibre Channel transceiver</td>
<td>47</td>
</tr>
<tr>
<td>Before you begin</td>
<td>48</td>
</tr>
<tr>
<td>Verifying component failure</td>
<td>48</td>
</tr>
<tr>
<td>Removing an SFP module</td>
<td>48</td>
</tr>
<tr>
<td>Installing an SFP module</td>
<td>49</td>
</tr>
<tr>
<td>Verifying component operation</td>
<td>50</td>
</tr>
<tr>
<td>Replacing a 10GbE SFP+ transceiver</td>
<td>50</td>
</tr>
<tr>
<td>Replacing a 1Gb RJ-45 SFP transceiver</td>
<td>50</td>
</tr>
<tr>
<td>Replacing a storage enclosure chassis</td>
<td>51</td>
</tr>
<tr>
<td>Before you begin</td>
<td>51</td>
</tr>
<tr>
<td>Verifying component failure</td>
<td>52</td>
</tr>
<tr>
<td>Preparing to remove a damaged storage enclosure chassis</td>
<td>52</td>
</tr>
<tr>
<td>Removing a damaged storage enclosure chassis from the rack</td>
<td>53</td>
</tr>
<tr>
<td>Installing the replacement storage enclosure in the rack</td>
<td>54</td>
</tr>
<tr>
<td>Completing the process</td>
<td>54</td>
</tr>
<tr>
<td>Verifying component operation</td>
<td>54</td>
</tr>
<tr>
<td>Using LEDs</td>
<td>55</td>
</tr>
<tr>
<td>Using management interfaces</td>
<td>55</td>
</tr>
<tr>
<td>Disk LEDs</td>
<td>58</td>
</tr>
</tbody>
</table>
Figures

1 Exploded view: controller or expansion enclosure (4U56) .................................................. 12
2 Ultra56 Series CNC controller module with SFP transceiver ........................................... 13
3 Partial assembly showing bezel alignment with 4U56 chassis ........................................... 14
4 Enclosure assembly with bezel installed (4U56) ................................................................. 14
5 Enclosure assembly with bezel removed (4U56) ............................................................... 14
6 Enclosure architecture: internal components sub-assembly (4U56) .................................... 14
7 Drawer detail showing handle rotation and drawer travel .................................................. 15
8 Rear-panel enclosure with FRUs installed (4U56) ............................................................ 19
9 Disengaging a controller module ....................................................................................... 24
10 Extracting a controller module ......................................................................................... 25
11 Removing a controller module .......................................................................................... 25
12 Inserting a controller module ............................................................................................ 26
13 Loosen the drawer stop screw .......................................................................................... 29
14 Revolve the handle to drawer-pull position ....................................................................... 29
15 Remove a disk from a drawer slot .................................................................................... 32
16 Install a disk into a drawer slot .......................................................................................... 33
17 AC and DC PSU ................................................................................................................... 37
18 DC power cable featuring 2-circuit header and lug connectors (4U) ................................. 38
19 Removing a power supply unit ............................................................................................ 38
20 Orienting a power supply unit ............................................................................................. 39
21 Installing a power supply unit ............................................................................................ 39
22 Connecting an AC power cord ........................................................................................... 40
23 Removing a fan control module ......................................................................................... 43
24 Installing a fan control module .......................................................................................... 44
25 Fan control module LED descriptions ................................................................................. 44
26 Replacing left ear components .......................................................................................... 45
27 Replacing right ear components ......................................................................................... 46
28 Sample SFP connector ........................................................................................................ 48
29 Disconnect fibre-optic interface cable from SFP ............................................................... 49
30 Flip SFP actuator upwards ................................................................................................. 49
31 Install the SFP into the CNC port ..................................................................................... 49
32 Enclosure front face pictorial featuring drawers ............................................................... 56
33 Schematic representation of drawers ................................................................................ 56
34 LEDs: 4U56 drawer status front panel layout ................................................................. 58
35 LED: 4U56 disk drive module ............................................................................................. 59
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Related documents</td>
<td>8</td>
</tr>
<tr>
<td>2</td>
<td>Document conventions</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>Individual enclosure models comprising Ultra56 Series storage systems</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>Ultra56 Series product components for 4U56 enclosures</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>Compatible drive enclosures for adding storage</td>
<td>16</td>
</tr>
<tr>
<td>6</td>
<td>Power supply faults and recommended actions</td>
<td>36</td>
</tr>
<tr>
<td>7</td>
<td>Power supply unit LED descriptions</td>
<td>41</td>
</tr>
<tr>
<td>8</td>
<td>Fan control module faults and recommended actions</td>
<td>42</td>
</tr>
<tr>
<td>9</td>
<td>Removing and replacing a 10GbE SFP+ transceiver</td>
<td>50</td>
</tr>
<tr>
<td>10</td>
<td>Removing and replacing a 1 Gb SFP transceiver</td>
<td>51</td>
</tr>
<tr>
<td>11</td>
<td>Removing and replacing a storage enclosure chassis and its FRUs</td>
<td>52</td>
</tr>
</tbody>
</table>
About this guide

Overview

This guide identifies Ultra56 Series FRUs (field-replaceable units), and describes how to remove or install them within the AssuredSAN™ Ultra56 Series storage enclosure products listed below:

• CNC (Converged Network Controller) Controller enclosure (4854 models):
  • Qualified Fibre Channel SFP option supporting (4/8/16 Gb)
  • Qualified Internet SCSI (10GbE) SFP option
  • Qualified Internet SCSI (1 Gb) Copper RJ-45 SFP option
• HD mini-SAS (12 Gb) Controller enclosure: 4554

For a complete description of product models, see the “Components” chapter within the Setup Guide.

AssuredSAN Ultra56 Series enclosures support both traditional linear storage and new virtual storage, which uses paged-storage technology. For linear storage, a group of disks with an assigned RAID level is called a vdisk or linear disk group. For virtual storage, a group of disks with an assigned RAID level is called a virtual disk group. This guide uses the term vdisk when specifically referring to linear storage, and uses the term disk group otherwise.

AssuredSAN Ultra56 Series enclosure user interfaces

The Ultra56 Series enclosures support two versions of the web-based application for configuring, monitoring, and managing the storage system. Both web-based application GUI versions (v3 and v2), and the command-line interface are briefly described:

• Storage Management Console (SMC) is the new primary web interface (v3) for the enclosures, providing access to all common management functions for both linear and virtual storage.
• RAIDar is a secondary web interface (v2) for the enclosures, providing access to traditional linear storage functions. This legacy interface provides certain functionality that is not available in the primary interface.
• The command-line interface (CLI) enables you to interact with the storage system using command syntax entered via the keyboard or scripting. You can set a CLI preference to use v3 or v2 terminology in command output and system messages.

NOTE: For more information about enclosure user interfaces, see the following:
  • AssuredSAN Ultra56 Series Storage Management Guide or online help
    The guide describes SMC (v3) and RAIDar (v2) GUIs.
  • AssuredSAN Ultra56 Series CLI Reference Guide

Intended audience

This guide is intended for storage system administrators.

Prerequisites

Prerequisites for installing and using this product include knowledge of:

• Servers and computer networks
• Network administration
• Storage system installation and configuration
• Storage area network (SAN) management and direct attach storage (DAS)
• Fibre Channel (FC), Internet SCSI (iSCSI), Serial Attached SCSI (SAS), and Ethernet protocols
Related documentation

Table 1  Related documents

<table>
<thead>
<tr>
<th>For information about</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhancements, known issues, and late-breaking information not included in product documentation</td>
<td>Release Notes</td>
</tr>
<tr>
<td>Overview of product shipkit contents and setup tasks</td>
<td>Getting Started*</td>
</tr>
<tr>
<td>Regulatory compliance and safety and disposal information</td>
<td>AssuredSAN Product Regulatory Compliance and Safety*</td>
</tr>
<tr>
<td>Using a rackmount bracket kit to install an enclosure into a rack</td>
<td>AssuredSAN Ultra56 Rackmount Bracket Kit Installation*</td>
</tr>
<tr>
<td>Product hardware setup and related troubleshooting</td>
<td>AssuredSAN Ultra56 Series Setup Guide</td>
</tr>
<tr>
<td>Obtaining and installing a license to use licensed features</td>
<td>AssuredSAN 4004 Series Obtaining and Installing a License</td>
</tr>
<tr>
<td>Using the v3 and v2 web interfaces to configure and manage the product</td>
<td>AssuredSAN Ultra56 Series Storage Management Guide</td>
</tr>
<tr>
<td>Using the command-line interface (CLI) to configure and manage the product</td>
<td>AssuredSAN Ultra56 Series CLI Reference Guide</td>
</tr>
<tr>
<td>Event codes and recommended actions</td>
<td>AssuredSAN Event Descriptions Reference Guide</td>
</tr>
<tr>
<td>Enclosure bezel installation, removal, and servicing.</td>
<td>AssuredSAN Ultra56 Series Enclosure Bezel Kit Installation*</td>
</tr>
</tbody>
</table>

* Printed document included in product shipkit.

For additional information, see Dot Hill’s Customer Resource Center web site: https://crc.dothill.com.

Document conventions and symbols

Table 2  Document conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue text</td>
<td>Cross-reference links and e-mail addresses</td>
</tr>
<tr>
<td>Blue, underlined text</td>
<td>Web site addresses</td>
</tr>
<tr>
<td>Bold text</td>
<td>• Key names</td>
</tr>
<tr>
<td></td>
<td>• Text typed into a GUI element, such as into a box</td>
</tr>
<tr>
<td></td>
<td>• GUI elements that are clicked or selected, such as menu and list</td>
</tr>
<tr>
<td></td>
<td>items, buttons, and check boxes</td>
</tr>
<tr>
<td>Italic text</td>
<td>Text emphasis</td>
</tr>
<tr>
<td>Monospace text</td>
<td>• File and directory names</td>
</tr>
<tr>
<td></td>
<td>• System output</td>
</tr>
<tr>
<td></td>
<td>• Code</td>
</tr>
<tr>
<td></td>
<td>• Text typed at the command-line</td>
</tr>
<tr>
<td>Monospace, italic text</td>
<td>• Code variables</td>
</tr>
<tr>
<td></td>
<td>• Command-line variables</td>
</tr>
<tr>
<td>Monospace, bold text</td>
<td>Emphasis of file and directory names, system output, code, and text typed at the command-line</td>
</tr>
</tbody>
</table>

△ CAUTION: Indicates that failure to follow directions could result in damage to equipment or data.
1 FRUs

Available FRUs

You can determine which FRUs pertain to your storage enclosure using the Command-line Interface (CLI). Access the controller via a Telnet client; log into the controller over the network (default user name manage and password !manage). If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the defaults shown above.

Enter a `show frus` query.

Execution of the `show frus` CLI command displays controller metadata, followed by the FRU information pertaining to chassis (with midplane), I/O modules (IOMs), disk drawers, and power supplies.

NOTE: See the AssuredSAN Ultra56 Series CLI Reference Guide for more information.

You can also determine which FRUs pertain to your storage enclosure by visual inspection of the component, noting serial number and part number. This method applies to disk drives. FRUs and FRU make-up are subject to change independent of documentation versions. Information about FRUs and other components can also be viewed via the SMC or RAIDar.


Storage enclosure overview

NOTE: Tables and companion illustrations describe field-replaceable units for Ultra56 Series products.

Table 3 provides summary descriptions of individual controller enclosure models comprising Ultra56 Series.

<table>
<thead>
<tr>
<th>Model</th>
<th>Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4854</td>
<td>4U56</td>
<td>Fibre Channel (8/16 Gb) SFP¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This model uses a qualified FC SFP option within the CNC ports (used for host connection or replication). When in FC mode, the SFPs must be a qualified 8 Gb or 16 Gb fibre optic option. A 16 Gbit/s SFP can run at 16 Gbit/s, 8 Gbit/s, 4 Gbit/s, or auto-negotiate its link speed. An 8 Gbit/s SFP can run at 8 Gbit/s, 4 Gbit/s, or auto-negotiate its link speed.</td>
</tr>
<tr>
<td>4854</td>
<td>4U56</td>
<td>Internet SCSI (10GbE) SFP¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This model uses a qualified 10GbE iSCSI option within the controller module CNC ports (used for host connection or replication).</td>
</tr>
<tr>
<td>4854</td>
<td>4U56</td>
<td>Internet SCSI (1 Gb) SFP¹</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This model uses a qualified 1 Gb iSCSI SFP option within the controller module CNC ports (used for host connection or replication).</td>
</tr>
<tr>
<td>4554</td>
<td>4U56</td>
<td>HD mini-SAS (12 Gb)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This model uses SFF-8644 connectors and qualified cable options for host connection.</td>
</tr>
</tbody>
</table>

¹CNC ports support same-type or mixed-type SFPs in combination as described in Transceivers used in CNC ports on page 47.
Table 4 shows components for 3.5" 56-drive enclosure models (4U56). Tables and supporting illustrations show components for Ultra56 Series that can be ordered for replacement in the field. Contact your account manager for packaged FRU numbers and ordering information.

FRUs addressing 56-drive enclosures

<table>
<thead>
<tr>
<th>Item</th>
<th>Enclosure component descriptions</th>
</tr>
</thead>
</table>
| 1    | Enclosure drawer (shown pulled forward to drawer stop)  
|      | a) Empty drawer chassis assembly (PCBAs, power module and SAS data cable connector)  
|      | b) 3.5" disk drive module (disks of differing type/speed and storage capacity: SAS, SSD) |
| 2    | Ear kit  
|      | a) Left ear assembly  
|      | b) Right ear assembly  
|      | Also see Partial assembly showing bezel alignment with 4U56 chassis on page 13 |
| 3    | Chassis [with drawer slide and igus chain (data and power cables) shown] |
| 4    | Midplane (included with chassis) |
| 5    | Power supplies (one shown)  
|      | a) AC power supply for enclosure  
|      | b) Power supply extension module |
| 6    | Igus chainflex assembly (Shown coiled, with unplugged data and power cables. Connectors plug into horizontal PCBA at back-end of drawer) |
| 7    | Fan Control Module (two per enclosure) |
| 8    | Controller module for enclosure [two per controller enclosure] (see Figure 2 on page 13)  
|      | a) 4854, 1RM, 4-port CNC, FC [8/16 Gbit/s] SFP option  
|      | b) 4854, 1RM, 4-port CNC, iSCSI [10GbE] SFP option  
|      | c) 4854, 1RM, 4-port CNC, iSCSI [1 Gbit/s] RJ-45 SFP option  
|      | d) 4554, 1RM, HD mini-SAS, 4-port [12 Gbit/s] |
| 9    | Small form-pluggable (SFP) connector (applies to CNC controller modules only) |
| 10   | Enclosure cover (included with chassis) |
| Not shown | Expansion module (two per chassis when configured as an expansion enclosure)  
| Not shown | Rail kit [Rack mount rail kit, assembly, All HW] |
| Not shown | Cable kit [Cable package: mini-SAS (SFF-8088) to mini-SAS (SFF-8088)]  
|      | Cable kit [Cable package: HD mini-SAS (SFF-8644) to HD mini-SAS (SFF-8644)]  
|      | Cable kit [Cable package: HD mini-SAS (SFF-8644) to mini-SAS (SFF-8088)] |
| Not shown | Cable kit [Cable package: USB Type B; CLI (USB)] |
| Not shown | AC power cord compatible with AC power supply unit; or  
|      | DC power cable compatible with DC power supply unit |

The numbered items listed in Table 4 below are pictorially shown in the companion illustrated parts breakdown (see Figure 1 on page 12).
Illustrated Parts Breakdown: 4U56 Chassis FRUs
(For clarity, redundant assembly components are not shown)

Orientation Key

Notes:
1. The enclosure bezel is only partially shown.
2. Ear kits are shown assembled and exploded.
3. The bezel is equipped with an EMI shield.
4. The bezel must be attached during enclosure operation.
5. Remove the bezel to access front panel components.
6. Use management interfaces in lieu of removing bezel.

Figure 1 Exploded view: controller or expansion enclosure (4U56)
Figure 1 through Figure 7 illustrate 56-drive enclosure models. The 4U56 product models use an enclosure bezel during operation. The enclosure bezel is only partially shown in Figure 1 on page 12. The enclosure bezel is shown in its entirety in Figure 3 on page 13 (removed) and in Figure 4 on page 14 (installed).

**NOTE:** The following illustrations further describe Table 4 components for the 4U56 chassis:
- Controller module pictorial — Figure 2
- Assembly — Figure 3 and Figure 7

![CNC controller module](enlarged relative to Figure 1)

**Figure 2** Ultra56 Series CNC controller module with SFP transceiver

The transceiver is shown exploded from the IOM in the CNC example. Controller modules equipped with CNC ports support qualified FC (8 Gbit/s, 16 Gbit/s), 10GbE iSCSI, and 1 Gb RJ-45 SFP options. Controller modules equipped with HD mini-SAS ports use qualified SFF-8644 external connectors.

![Partial assembly showing bezel alignment with 4U56 chassis](Vented grille is simplified for clarity)

**Figure 3** Partial assembly showing bezel alignment with 4U56 chassis

**NOTE:** For further information, see the AssuredSAN Ultra56 Enclosure Bezel Kit Installation instructions in your product shipkit.
Enclosure bezel attachment

Orient the enclosure bezel to align its back side with the front face of the enclosure. Tilt the bezel forward, and guide the two angle-bracket slots on the backside of the bezel onto the two upturned flanges located on sidemount brackets near the front of the enclosure (on the exterior left and right chassis walls). Then, gently push the sleeves onto the ball studs as shown in the details in Figure 3.

Enclosure bezel removal

While facing the front of the enclosure, insert the index finger of each hand into the top of the respective (left or right) pocket opening. Gently pull the top of the bezel while applying slight inward pressure below to release the top sleeves from the ball studs. Lift the bezel upwards to allow the angle-bracket slots to clear the upturned mounting flanges.

Enclosure bezel for 56-drive model

The 56-drive 4U56 enclosure supports a bezel sub-assembly that attaches to the front of the chassis (see Figure 3 on page 13). The bezel—comprised of a vented cover attached to an EMI (Electromagnetic Interference) shield—is pre-assembled and packed with foam into a box included in the master shipping container.

Figure 7 Drawer detail showing handle rotation and drawer travel

Once you have removed the bezel, you can access the drawers. To open a drawer, you must first revolve the pull-handle downwards by 90° to enable pulling the drawer outward for viewing disks. The handle can be in the stowed position when pushing the drawer back into the enclosure along the drawer slide.
Supported drive enclosures

Table 5  Compatible drive enclosures for adding storage

<table>
<thead>
<tr>
<th>Model</th>
<th>Form</th>
<th>Enclosure description</th>
<th>Disk drives</th>
<th>Rear panel connection</th>
<th>NEBS</th>
</tr>
</thead>
<tbody>
<tr>
<td>J6G56</td>
<td>4U56</td>
<td>56-drive 6 Gbit/s chassis with FRUs</td>
<td>3.5&quot; (LFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 4</td>
</tr>
<tr>
<td>J6G48</td>
<td>2U48</td>
<td>48-drive 6 Gbit/s chassis with FRUs</td>
<td>2.5&quot; (SFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 4</td>
</tr>
<tr>
<td>J6G24</td>
<td>2U24</td>
<td>24-drive 6 Gbit/s chassis with FRUs</td>
<td>2.5&quot; (SFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 4</td>
</tr>
<tr>
<td>J6G12</td>
<td>2U12</td>
<td>12-drive 6 Gbit/s chassis with FRUs</td>
<td>3.5&quot; (LFF)</td>
<td>mini-SAS to mini-SAS</td>
<td>Note 4</td>
</tr>
</tbody>
</table>

1These 4004 Series-compatible expansion enclosure models feature 6 Gbit/s internal disk and SAS expander link speeds. See the 4004 Series Setup and FRU guides for information about 2U24 and 2U12 enclosures.
2See the AssuredSAN Ultra56 Series Setup Guide—and this guide—for information about the high-capacity 4U56 chassis form factor.
3See the Ultra56 Series Setup Guide for maximum enclosure limits and associated cabling configurations.
4The 4004 Series and Ultra56 Series are designed for NEBS compliance, but the Ultra48 Series—which includes the J6G48—is not.
2 Procedures

This chapter provides procedures for replacing FRUs (field-replaceable units), including precautions, removal instructions, installation instructions, and verification of successful installation. Each procedure addresses a specific task. Certain procedures refer to related documentation. See Related documentation on page 8 for a list of these documents and where to find them online.

Electrostatic discharge

Before you begin any of the procedures, consider the following precautions and preventive measures.

Preventing electrostatic discharge

To prevent electrostatic discharge (ESD) from damaging the system, be aware of the precautions to consider when setting up the system or handling parts. A discharge of static electricity from a finger or other conductor may damage system boards or other static-sensitive devices. This type of damage may reduce the life expectancy of the device.

⚠️ CAUTION: Parts can be damaged by electrostatic discharge. Follow these precautions:
- Avoid hand contact by transporting and storing products in static-safe containers.
- Keep electrostatic-sensitive parts in their containers until they arrive at static-protected workstations.
- Place parts in a static-protected area before removing them from their containers.
- Avoid touching pins, leads, or circuitry.
- Always be properly grounded when touching a static-sensitive component or assembly.
- Remove clutter (plastic, vinyl, foam) from the static-protected workstation.

Grounding methods to prevent electrostatic discharge

Several methods are used for grounding. Adhere to the following precautions when handling or installing electrostatic-sensitive parts.

⚠️ CAUTION: Parts can be damaged by electrostatic discharge. Use proper anti-static protection:
- Keep the replacement FRU in the ESD bag until needed; and when removing a FRU from the enclosure, immediately place it in the ESD bag and anti-static packaging.
- Wear an ESD wrist strap connected by a ground cord to a grounded workstation or unpainted surface of the computer chassis. Wrist straps are flexible straps with a minimum of 1 megohm (± 10 percent) resistance in the ground cords. To provide proper ground, wear the strap snug against the skin.
- If an ESD wrist strap is unavailable, touch an unpainted surface of the chassis before handling the component.
- Use heel straps, toe straps, or boot straps at standing workstations. Wear the straps on both feet when standing on conductive floors or dissipating floor mats.
- Use conductive field service tools.
- Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, have an authorized reseller install the part. For more information about static electricity or assistance with product installation, contact an authorized reseller.
Replacing chassis FRU components

Chassis FRUs replace a damaged chassis or chassis components. A fully functional chassis requires successful installation of the following components:

- Two controller modules of the same model (for a given controller enclosure)*
  See Replacing a controller module or expansion module on page 19 for more information.
- All disk drive modules
  See Replacing a disk drive module on page 30 for more information.
- Two power supply modules of the same type (both AC or both DC)
  See Replacing a power supply module on page 35 for more information.
- Two fan control modules
  See Replacing a fan control module on page 41 for more information.
- Two ears with components installed (complementary left and right ear kits)
  See Replacing ear components on page 45 for more information; also see Figure 3 on page 13 for 4U56 enclosure bezel alignment.
- Two expansion modules of the same model (per optional expansion enclosure)*
  See Replacing a controller module or expansion module on page 19 for more information.

*Each I/O module (IOM) slot within the chassis must contain an IOM to enable optimum air flow through the enclosure during operation. Whether configured as a controller enclosure or a drive enclosure, the Ultra56 Series chassis supports dual-controller configuration only.

In addition to the FRUs identified above, replacement procedures are provided to address specific interface protocols and replacement of the enclosure chassis:

- Removal and installation of a Fibre Channel transceiver
  See Replacing a Fibre Channel transceiver on page 47 for more information.
- Removal and installation of a 10GbE SFP+ transceiver
  See Replacing a 10GbE SFP+ transceiver on page 50 for more information.
- Removal and installation of a 1 Gb RJ-45 SFP transceiver
  See Replacing a 1Gb RJ-45 SFP transceiver on page 50 for more information.
- Removal and installation of a storage enclosure chassis
  See Replacing a storage enclosure chassis on page 51 for more information.

Replacement of chassis FRU components are described within this chapter.

**NOTE:** Ultra56 Series controller enclosures support hot-plug replacement of redundant controller modules, fans, power supplies, and I/O modules. Hot-add of drive enclosures is also supported.

**TIP:** Many procedures refer to component LEDs and LED statuses. See the AssuredSAN Ultra56 Series Setup Guide for descriptions of model-specific front panel and rear panel LEDs.

**TIP:** Within the AssuredSAN Ultra56 Series Setup Guide, see “Troubleshooting > Fault isolation methodology” for information about using health icons/values—in addition to using LEDs—for verifying component failure before actually replacing the FRU.
Figure 8 shows the rear-panel of the enclosure with FRUs installed. The controller modules are top-loaded above the two fan control modules. The fan control modules are located between the two power supply modules (either both AC or both DC).

Replacing a controller module or expansion module

In a dual-controller configuration, controller and expansion modules are hot-swappable, which means you can replace one module without halting I/O to disk groups, or powering off the enclosure. In this case, the second module takes over operation of the storage system until you install the new module.

You may need to replace a controller module or an expansion module when:

- The Fault/Service Required LED is illuminated
- Health status reporting in the SMC or RAIDar indicates a problem with the module
- Events in RAIDar indicate a problem with the module
- Troubleshooting indicates a problem with the module

**NOTE:** Ultra56 Series controller enclosures equipped with CNC controller modules support the optionally-licensed AssuredRemote™ replication feature; whereas enclosures equipped with SAS controller modules do not.

**CAUTION:** When replacing an Ultra56 Series controller set supporting AssuredRemote with an Ultra56 Series controller set that does not support this licensed feature, you must first delete all replication sets before swapping the controller modules. Not doing so will lead to unexpected results, and there is no way to delete replication sets after the installation. See the following for additional information:

- AssuredSAN Ultra56 Series Storage Management Guide
- AssuredSAN Ultra56 Series CLI Reference Guide
Before you begin

Removing a controller or expansion module from an operational enclosure significantly changes air flow within the enclosure. Openings must be populated for the enclosure to cool properly. Leave modules in the enclosure until ready to install a replacement. If replacing both controllers in the dual-control enclosure, use the SMC or RAIDar to record configuration settings before installing the new controller modules. See Removing a controller module or expansion module on page 24, and Installing a controller module or expansion module on page 25 for instructions.

⚠️ CAUTION: When replacing a controller module, ensure that less than 10 seconds elapse between inserting it into a slot and fully latching it in place. Not doing so might cause the controller to fail. If it is not latched within 10 seconds, remove the controller module from the slot, and repeat the process.

The two controller modules installed in the enclosure must be of the same model type. When replacing both controller modules in an operational enclosure, follow these guidelines:

1. Replace one controller as described in these instructions.
2. Wait 30 minutes: this pause ensures that the controller and its ownership of disk groups has sufficient time to stabilize (also see Verifying component operation on page 26).
3. Check the system status and event logs to verify that the system is stable.
4. Replace the partner controller as described in these instructions.

Configuring partner firmware update

In a dual-controller system in which Partner Firmware Update (PFU) is enabled, when you update firmware on one controller, the system automatically updates the partner controller. Disable partner firmware update only if requested by a service technician.

Use the SMC, RAIDar, or the CLI to change the PFU setting.

Using the SMC or RAIDar

⚠️ IMPORTANT: See the “Updating firmware” topic within the AssuredSAN Ultra56 Series Storage Management Guide before performing a firmware update.

To change the PFU setting using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. Click in the System panel in the banner, and select Action > Update Firmware.
   The Update Firmware panel opens. The Update Controller Modules tab shows versions of firmware components that are currently installed in each controller.

   **NOTE:** The SMC does not provide a check-box for enabling or disabling Partner Firmware Update for the partner controller. To enable or disable the setting, use the set advanced-settings command, and set the partner-firmware-upgrade parameter. See the CLI Reference Guide for more information about command parameter syntax. Also see Using the CLI on page 21.

To change the PFU setting using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. Click in the Configuration View panel, right-click the system and select Configuration > Advanced Settings > Firmware.

3. Either select (check) the Partner Firmware Update check box to enable the option, or clear the check box to disable the option.

4. Click Apply.

Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages.

**TIP:** The following CLI commands enable you to set the management mode to v3 or v2:
- Use `set protocols` to change the default management mode.
- Use `set cli-parameters` to change the current management mode for the CLI session.

The system defaults to v3 for new customers and v2 for existing users (see the CLI Reference Guide for more information).

1. Log-in to the command-line interface using default user `manage` and password `!manage`.
   - If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.

2. To verify that partner firmware upgrade is enabled, run the following command:
   ```bash
   show advanced-settings
   ```

3. If partner firmware upgrade is disabled, enable it by running the following command:
   ```bash
   set advanced-settings partner-firmware-upgrade enabled
   ```

**NOTE:** See the AssuredSAN Ultra56 Series CLI Reference Guide for additional information.

Verifying component failure

Select from the following methods to verify component failure:
- Use the SMC or RAIDar to check the health icons/values of the system and its components to either ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar use health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
- As an alternative to using the SMC or RAIDar, you can run the `show system` command in the CLI to view the health of the system and its components. If any component has a problem, the system health will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
- Monitor event notification — With event notification configured and enabled, use the SMC or RAIDar to view the event log, or use the CLI to run the `show events detail` command to see details for events.
- Check Fault/Service Required LED (back of enclosure): Amber = Fault condition
- Check that the FRU OK LED (back of enclosure) is off

Stopping I/O

When troubleshooting disk drive and connectivity faults, stop I/O to the affected disk groups from all hosts and remote systems as a data protection precaution. As an additional data protection precaution, it is helpful to conduct regularly scheduled backups of your data.
**IMPORTANT:** Stopping I/O to a disk group is a host-side task, and falls outside the scope of this document.

When on-site, you can verify that there is no I/O activity by briefly monitoring the system LEDs; however, when accessing the storage system remotely, this is not possible. Remotely, you can use the `show disk-group-statistics` command to determine if input and output has stopped. Perform these steps:

1. Using the CLI, run the `show disk-group-statistics` command.
   
   The *Number of Reads* and *Number of Writes* outputs show the number of these operations that have occurred since the statistic was last reset, or since the controller was restarted. Record the numbers displayed.

2. Run the `show disk-group-statistics` command a second time.
   
   This provides you a specific window of time (the interval between requesting the statistics) to determine if data is being written to or read from the disk. Record the numbers displayed.

3. To determine if any reads or writes occur during this interval, subtract the set of numbers you recorded in step 1 from the numbers you recorded in step 2.
   
   • If the resulting difference is zero, then I/O has stopped.
   
   • If the resulting difference is not zero, a host is still reading from or writing to the disk group.
     
     Continue to stop I/O from hosts, and repeat step 1 and step 2 until the difference in step 3 is zero.

**NOTE:** See the AssuredSAN Ultra56 Series CLI Reference Guide for additional information.

### Shutting down a controller module

Shutting down the Storage Controller in a controller module ensures that a proper failover sequence is used, which includes stopping all I/O operations and writing any data in write cache to disk. If the Storage Controller in both controller modules is shut down, hosts cannot access the system’s data. Perform a shut down before you remove a controller module from an enclosure, or before you power off its enclosure for maintenance, repair, or a move.

**⚠️ CAUTION:** You can continue to use the CLI when either or both Storage Controllers are shut down, but information shown might be invalid.

Use the SMC, RAIDar, or the CLI to perform a shut down.

#### Using the SMC or RAIDar

To shut down using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.
   
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown.

2. In the System panel in the banner, click and select Restart System.
   
   The Controller Restart and Shut Down panel opens.

3. Select the Shut Down operation, which automatically selects the controller type Storage.

4. Select the controller module to shut down: A, B, or both.

5. Click OK. A confirmation panel appears.

6. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

**NOTE:** If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.
To shut down using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.

2. In the Configuration View panel, right-click the system and select **Tools > Shut Down or Restart Controller**.
   The Shut Down or Restart Controller panel appears.

3. In the Shut Down or Restart Controller panel, set the options:
   - **Operation**: select **Shut down**.
   - **Controller type**: select **Storage**.
   - Within the **Controller** field, select **A**, **B**, or **Both**.

4. Click **Shut down now**. A confirmation dialog appears.

5. Click **Yes** to continue; otherwise click **No**. If you clicked Yes, a second confirmation dialog appears.

6. Click **Yes** to continue; otherwise, click **No**. If you clicked Yes, a message describes shutdown activity.

   **NOTE:** If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.

   **NOTE:** See the AssuredSAN Ultra56 Series Storage Management Guide for additional information.

---

**Using the CLI**

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

1. Log-in to the CLI using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.

2. In a dual-controller system, verify that the partner controller is online by running the command:
   `show controllers`

3. Shut down the failed controller—A or B—by running the command:
   `shutdown a` or `shutdown b`
   The blue OK to Remove LED (back of enclosure) illuminates to indicate that the controller module can be safely removed.

4. Illuminate the identification LED of the enclosure that contains the controller module to remove by running the command:
   `set led enclosure 0 on`

   **NOTE:** See the AssuredSAN Ultra56 Series CLI Reference Guide for additional information.
Removing a controller module or expansion module

**IMPORTANT:**
- In dual-controller configurations featuring one healthy partner controller, there is no need to transport failed controller cache to a replacement controller because the cache is duplicated between the controllers (subject to volume write optimization setting).
- Ultra56 Series enclosures support dual-controller environments only. Do not transport the CompactFlash since data corruption might occur. Single-controller support is provided only when a controller fails over to its partner controller.
- In a dual-controller environment, you may hot-replace a single controller module in an operational enclosure, provided you first shut down the faulty controller using the SMC, RAIDar, or the CLI.
- In a dual-controller environment—if replacing both controller modules—you must adhere to the instructions provided in Before you begin on page 20.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” page 17.

**NOTE:** Within these procedures, illustrations featuring controller module face plates are generic. They do not show host interface ports, and they pertain to all Ultra56 Series controller module models. For illustrations of model-specific controller face plates, see the AssuredSAN Ultra56 Series Setup Guide.

Illustrations in the controller module replacement procedures show rear panel views of the enclosure, and IOMs are properly aligned for insertion into the rear panel of the enclosure.

1. Verify that you have successfully shut down the controller module using the SMC, RAIDar, or the CLI.
2. Locate the enclosure whose Unit Locator LED (front right ear) is illuminated, and within the enclosure, locate the controller module whose OK to Remove LED is blue (rear panel).
3. Disconnect any cables connected to the controller.
   Label each cable to facilitate re-connection.
4. Turn the thumbscrews counterclockwise until they disengage from the controller (see Figure 9 on page 24).

![Figure 9 Disengaging a controller module](image)

5. Press both latches downward to disconnect the controller module from the midplane (see Figure 10).
6. Pull the controller module straight out of the enclosure such that the controller module remains level during removal (see Figure 11).

Installing a controller module or expansion module

**TIP:** You can install a controller module into an enclosure that is powered on, provided you wait 60 seconds after removing the old controller module. Check controller and midplane power connectors before inserting the new controller module into the enclosure.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

1. Loosen the thumbscrews; press the latches downward (see Figure 12 on page 26).
2. Ensuring that the controller module is level, slide it into the enclosure as far as it will go (1).
   A controller module that is only partially-seated will prevent optimal performance of the controller enclosure. Verify that the controller module is fully-seated before continuing.
3. Press the latches upward to engage the controller module (2); turn the thumbscrews clockwise until finger-tight.
4. Reconnect the cables.

NOTE: See the AssuredSAN Ultra56 Series Setup Guide for cabling information.

Figure 12 Inserting a controller module

IMPORTANT: In a dual-controller system in which PFU is enabled, when you update firmware on one controller, the system automatically updates the partner controller.

Verifying component operation

After replacing the controller module, verify that the FRU OK LED (rear panel) illuminates green, indicating that the controller has completed initializing, and is online/operating normally. It may take two to five minutes for the replacement controller to become ready. If you are replacing either controller module, and PFU is enabled, you may need to wait 30 minutes to ensure that the two controllers—with their respective ownership of the vdisks or disk groups—have enough time to fully stabilize.

Use the SMC, RAIDar, or the CLI to perform a restart only if necessary.

IMPORTANT: Use the SMC, RAIDar, or the CLI to perform a restart only if necessary. See the “Restarting controllers” topic in the Storage Management Guide for more information.

Using the SMC or RAIDar

To restart the controller using the SMC (v3):

1. Sign-in to the SMC using default user manage and password !manage.

   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown.

2. In the System panel in the banner, click and select Restart System.

   The Controller Restart and Shut Down panel opens.

3. Select the Restart operation.
4. Select the controller type to restart: Management or Storage.
5. Select the controller module to shut down: A, B, or both.
6. Click OK. A confirmation panel appears.
7. Click Yes to continue; otherwise, click No. If you clicked Yes, a message describes shutdown activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: Initiator failed to connect to the target.

To restart the controller using RAIDar (v2):

1. Sign-in to RAIDar using default user manage and password !manage.
   If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. In the Configuration View panel, right-click the system and select Tools > Shut Down or Restart Controller.
3. In the main panel, set the options:
   • Operation: Select Restart.
   • Controller Type: Select the controller type to restart: Management or Storage.
   • Controller: Select the controller module to restart: A, B, or Both.
4. Click Restart now. A confirmation panel appears.
5. Click Yes to continue; otherwise, click No. If you click Yes, a second confirmation diagram appears.
6. Click Yes to continue; otherwise click No. If you click Yes, a message describes restart activity.

NOTE: If an iSCSI port is connected to a Microsoft Windows host, the following event is recorded in the Windows event log: A connection to the target was lost, but Initiator successfully reconnected to the target.

Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

If the enclosure’s Unit Locator LED is on, run the following command to turn it off:

```
set led enclosure 0 off
```

If the Fault/Service Required LED is amber, the controller module has not gone online, and likely failed its self-test. Put the module online by restarting the controller, or by checking the event log for errors.

To restart the Management Controller (A or B), run the following command:

```
restart mc a or restart mc b or restart mc both
```

To restart the Storage Controller (A or B), run the following command:

```
restart sc a or restart sc b or restart sc both
```

TIP: See the AssuredSAN Ultra56 Series Setup Guide for descriptions of model-specific LEDs.

Updating firmware

You can view the current versions of firmware in controller modules, expansion modules (in drive enclosures), and disks (in drawers), and you can also install new firmware versions.
**TIP:** To ensure success of an online update, select a period of low I/O activity. This helps the update complete as quickly as possible and avoids disruptions to hosts and applications due to timeouts. Attempting to update a storage system that is processing a large I/O-intensive batch job will likely cause hosts to lose connectivity with the storage system.

Ultra56 Series enclosures are configured with dual-IOMs. In a dual-controller system, both I/O modules should run the same firmware version. Storage systems in a replication set must run compatible firmware versions. You can update the firmware in each IOM by loading a firmware file obtained from the enclosure vendor.

If the PFU option is enabled, when you update one controller, the system automatically updates the partner controller. If PFU is disabled, after updating firmware on one controller, you must log into the partner controller’s IP address and perform this firmware update on that controller also.

**NOTE:** If a vdisk (v2) or disk group (v3) is quarantined, firmware update is not permitted due to the risk of losing unwritten data that remains in cache for the vdisk or disk group. Before you can update firmware, you must resolve the problem causing the quarantine, as described in the Storage Management Guide, online help, or the CLI Reference Guide (see dequarantine CLI command).

For best results, the storage system should be in a healthy state before starting firmware update. You can update firmware using the SMC, RAIDar, or by using FTP (File Transfer Protocol). See the Storage Management Guide for more information.

**IMPORTANT:** See the “Updating firmware” topic within the AssuredSAN Ultra56 Series Storage Management Guide before performing a firmware update.

### Accessing a drawer

The 4U56 enclosure includes two different drawers: one for the left (Drawer 0) and right (Drawer 1) drawers. See Appendix A — Drawer description for a summary overview of disk slot numbering and drawer-loading requirements for the Ultra56 Series enclosure.

### Opening and closing a drawer

You can open a drawer for visual inspection of disks while the drawer is in operation. Before accessing the drawer via its handle, you must first remove the enclosure bezel (see narrative instructions beneath Figure 3 on page 13). Given that the enclosure bezel is required to provide EMI protection for disks, you should re-attach the bezel to the enclosure after examining the drawer.

1. Using a No. 2 Phillips screwdriver, loosen the two screws securing the handle to the front face of the drawer (see Loosen the drawer stop screw on page 29).
   
   Once the two screws on the target drawer are loosened, turn the thumbwheel counter-clockwise to disengage the handle from its upright stowed position.

2. Move the drawer toggle to enable the target drawer to travel along the slide.
   
   Move the toggle to the right to open Drawer 0 (left drawer); or move the toggle to the left to open Drawer 1 (right drawer).

3. Revolve the drawer handle downwards by 90° to enable pulling the drawer outward for viewing disk slots (see Revolve the handle to drawer-pull position on page 29).

4. Face the front of the drawer—and using the handle—pull the drawer outward along the drawer slide until it meets the first drawer stop.
   
   The second stop is met by using your index fingers to pull the blue clips (located on both sides of the drawer) towards the front of the drawer. Pull the drawer outward until it meets the next drawer stop.
NOTE: Do not pull out a drawer that is fully loaded with disks to the second stop.

To close the drawer, simply slide the drawer into the enclosure along the drawer slide until it properly seats in the drawer bay. Take care to ensure that no loose cable wires protrude beyond the limits of the igus chainflex cable. Note that the drawer will lock at the second stop. To release the lock, use your index fingers to pull the blue clips towards the front of the drawer and slide the drawer into the enclosure. After closing the drawer, revolve the handle upwards such that it is flush with the drawer front panel—in stowed position—and tighten the two handle screws. Re-attach the bezel to the front of the enclosure.

**Figure 13** Loosen the drawer stop screw

**Figure 14** Revolve the handle to drawer-pull position
Replacing a disk drive module

A disk drive module consists of a disk in a sled. Disk drive modules are hot-swappable, which means they can be replaced without halting I/O to the disk groups, or powering off the enclosure. The new disk drive module must be of the same type, and possess capacity equal to or greater than the one being replaced. Otherwise, the storage system cannot use the new disk to reconstruct the disk group.

FDE considerations

The Full Disk Encryption feature available via the management interfaces requires use of self-encrypting drives (SED) which are also referred to as FDE-capable disk drive modules. When installing FDE-capable disk drive modules, follow the same procedures for installing disks that do not support FDE. The exception occurs when you move FDE-capable disk drive modules for one or more disk groups to a different system, which requires additional steps.

The procedures for using the FDE feature, such as securing the system, viewing disk FDE status, and clearing and importing keys are performed using the SMC or RAIDar application, or CLI commands (see the Storage Management Guide guide or CLI Reference Guide for more information).

NOTE: When moving FDE-capable disk drive modules for a disk group, stop I/O to the disk group before removing the disk drive modules. Import the keys for the disks so that the disk content becomes available.

While replacing or installing FDE-capable disk drive modules, consider the following:

- If you are installing FDE-capable disks drive modules that do not have keys into a secure system, the system will automatically secure the disks after installation. Your system will associate its existing key with the disks, and you can transparently use the newly-secured disks.
- If the FDE-capable disk drive modules originate from another secure system, and contain that system’s key, the new disks will have the Secure, Locked status. The data will be unavailable until you enter the passphrase for the other system to import its key. Your system will then recognize the metadata of the disk group and incorporate it. The disks will have the status of Secure, Unlocked and their contents will be available:
  - To view the FDE status of disks, use the SMC, RAIDar, or the `show fde-state` CLI command.
  - To import a key and incorporate the foreign disks, use the SMC, RAIDar, or the `set fde-import-key` CLI command.

NOTE: If the FDE-capable disks contain multiple keys, you will need to perform the key importing process for each key to make the content associated with each key become available.

- If you do not want to retain the disks’ data, you can repurpose the disks. Repurposing disks deletes all disk data, including lock keys, and associates the current system’s lock key with the disks.
  To repurpose disks, use the SMC, RAIDar, or the `set disk` CLI command.
- You need not secure your system to use FDE-capable disks. If you install all FDE-capable disks into a system that is not secure, they will function exactly like disks that do not support FDE. As such, the data they contain will not be encrypted. If you decide later that you want to secure the system, all of the disks must be FDE-capable.
- If you install a disk module that does not support FDE into a secure system, the disk will have the Unusable status and will be unavailable for use.
- If you are re-installing your FDE-capable disk drive modules as part of the process to replace the chassis-and-midplane FRU, you must insert the original disks and re-enter their FDE passphrase.
Before you begin

⚠️ CAUTION: Removing a disk drive module impacts the airflow and cooling ability of the enclosure. If the internal temperature exceeds acceptable limits, the enclosure may overheat and automatically shut down or restart. To avoid potential overheating, wait 20 seconds to allow the internal disks to stop spinning, then insert the new disk drive module.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

Verifying component failure

Before replacing a disk, perform the following steps to ensure that you have correctly identified the module requiring removal and replacement.

⚠️ CAUTION: Failure to identify the correct disk drive module could result in data loss if the wrong disk is removed from the enclosure.

For line-of-sight viewing of individual disk LEDs, you must remove the enclosure bezel and open the drawer to view its installed disks and blanks (if used). When a disk fails or a fault occurs, the disk LED illuminates with a 4Hz (4:1) blue blink behavior (see the AssuredSAN Ultra56 Series Setup Guide for a description of LEDs and disk drive slot numbering for your enclosure. Also see Appendix A — Drawer description for a summary). You can determine from visual inspection which disk in the drawer is experiencing a fault/failure.

Alternatively, you can observe disk component health using management interfaces to verify component failure or component operation (see Using management interfaces on page 55 for more information).

Removing a disk drive module

To access disk slots in the drawer bays, you must first do the following:

• Remove the enclosure bezel (see narrative instructions following Figure 3 on page 13).
• Pull the drawer outward as described in Opening and closing a drawer on page 28.

⚠️ IMPORTANT: Drawer and disk slot numbering are described pictorially on the adhesive label laminated to the exterior wall of each drawer. Disk slot numbering for drawers 0 (left) and 1 (right) begins at the front of the drawer and moves inward (row-by-row) along the x-axis.

⚠️ IMPORTANT: Familiarize yourself with FDE considerations on page 30 before performing this step-procedure.

⚠️ IMPORTANT: Disk module removal guidelines:
• Stop I/O to the disk (see Stopping I/O on page 21).
• Remove only one disk drive module at a time: concurrent/multiple disk module removal is not allowed.
• Remove the disk module (per step procedure)—wait 30 seconds—before removing another disk.

1. Using your index finger, slide the release latch—located in the upper pocket on the face of the disk drive module—forward to disengage the disk drive module (see detail inset view in Figure 15).

Moving the latch forward will provide a clicking sound and cause the spring to move its position inside the drawer cage, partially ejecting the disk from its installed position within the disk drive slot.
2. Wait 20 seconds for the internal disks to stop spinning.
3. Once the disk drive module partially ejects from the slot, grasp the module firmly, and carefully pull it straight out of the drawer slot. Take care not to drop the module.

Installing a disk drive module

To access disk slots in the drawer bays, you must first do the following:

- Remove the enclosure bezel (see Enclosure bezel removal on page 15).
- Pull the drawer outward as described in Opening and closing a drawer on page 28.

**IMPORTANT:** Familiarize yourself with FDE considerations on page 30 before performing this step-procedure to mitigate the potential for unusable installed disks.

**IMPORTANT:** Disk module installation guidelines:

- Install only *one* disk drive module at a time: concurrent/multiple disk module insertions are not allowed.
- Install the disk module (per step procedure)—wait 45 seconds—before installing another disk module.

**IMPORTANT:** As you install multiple disks into the drawer, populate from back row to front row, while installing disks into the slots. Provide adequate support for the weight of the extended drawer as you install the disks. An exception to this statement occurs if you are installing disk modules to partially fill a drawer, in which case you must install a minimum of 14 disk modules, and they must be placed in contiguous slots closest to the front of the drawer.

The enclosure uses an LFF sledged disk positioned to stand on end, for insertion into the disk slot within the drawer. Each disk is mated to a connector on the drawer PCBA.

1. With the disk module standing on end—and the LEDs oriented to the left—insert the disk module into the vertically-aligned disk slot. Notches on the inside of the drawer will help guide the disk to the correct position and seat the disk into the connector on the drawer PCBA.

![Figure 15 Remove a disk from a drawer slot](image)
2. Verify that you have inserted the disk module into the slot as far as it will go. A spring in the drawer slot will provide a resistive force when mating the drive to the connector. This will ensure that the module is firmly seated in the drawer PCBA.

![Figure 16 Install a disk into a drawer slot](image)

---

**NOTE:** Allow at least 30 seconds to elapse when jointly completing the “Removing a disk drive module” and “Installing a disk drive module” procedures.

If using the SMC, execute steps 3—5 to complete this procedure. If using RAiDar, execute steps 6 and 7 to complete this procedure. If using the CLI, execute steps 8 and 9 to complete this procedure.

**IMPORTANT:** If you install an empty disk and intend to use it as a spare, the disk must be enabled as a spare in order for this procedure to be complete. Spares can be managed using the SMC, RAiDar, or the CLI.

**Using the SMC (v3):**

3. Sign in to the SMC (use default user manage and password !manage, or the appropriate username and password if they have been changed).

4. Click the System topic. The System panel opens.

5. Click the Table tab to determine whether the health of the new disk is OK. If the health is OK, then the disk drive module installation process is complete. If the health is not OK, then hover over the disk to display details about it, such as Status and Health Recommendations.

**Using RAiDar (v2):**

6. Sign in to RAiDar (use default user manage and password !manage, or the appropriate username and password if they have been changed).

7. View the System Overview panel to determine whether the health of the new disk is OK. If the health is OK, then the disk drive module installation process is complete. If the health is not OK, then in the Configuration View panel, select the enclosure that the new disk is in to display the Enclosure Overview panel, and select the disk to view details about it, such as Status and Health Recommendations.

**Using the CLI:**

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

8. Log in to the CLI (use default user manage and password !manage, or the appropriate username and password if they have been changed).

9. To view information about disks, run the following command:

   `show disks <disk-ID>`
Disks are specified by enclosure ID and slot number. Enclosure IDs increment from 0. Disk IDs increment from 0 in each enclosure (e.g., `show disks 0.7`). Entering the command shown above will display the disk health for the disk residing in slot number 7 of enclosure number 0 (i.e., the controller enclosure). If health is not OK, the command output will also display recommended actions.

### Determine if a disk is missing

You can determine whether a disk is missing by using management interfaces.

#### Using the SMC or RAIDar

To determine whether a disk is missing by using the SMC (v3):

1. Sign-in to the SMC using default user `manage` and password `!manage`. If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. Click the **System** topic. The System panel opens.
   - Select the **Front** tab to display a pictorial representation of disks within slots, and hover over individual disks to view the metadata such as location, usage, tier, type, and size.
   - You can hover over enclosure ears to see metadata for specific enclosures in the system.
   - Select the **Table** tab to display a tabular view of information about physical components in the system.
3. Using the Front and Table views, look for gaps in the disk location sequence to determine if a disk is missing.

To determine whether a disk is missing by using RAIDar (v2):

1. Sign-in to RAIDar using default user `manage` and password `!manage`. If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. In the Configuration View panel, right-click the appropriate enclosure under **Physical**.
   - Select the **Front Graphical** tab to display a pictorial representation of disks within slots, and the supporting enclosure table showing properties and values.
   - Select the **Front Tabular** tab to display the Enclosure’s Front View data table and supporting enclosure table showing properties and values.
3. Using the graphical and tabular views, look for gaps in the disk location sequence to determine if a disk is missing.

#### Using the CLI

You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

1. Log-in to the command-line interface (CLI) using default user `manage` and password `!manage`. If the default user or password—or both—have been changed for security reasons, enter the secure login credentials instead of the system defaults shown above.
2. To determine location of a missing or faulty drive, run the following command:
   
   ```
   show disks
   ```

   The command outputs a listing of detected disks’ properties by location. Review the information, and look for gaps in the disk location sequence to determine whether any disks are missing.

### Verifying component operation

Verify that the Power/Activity LED—located on the front face of the disk drive escutcheon—is illuminated green.

- The disk module LED is shown in **Figure 16** on page 33.
- The disk module LED behavior is described in **Figure 35** on page 59.
Replacing a power supply module

This section provides procedures for replacing a failed AC or DC power supply module, also referred to as a power supply unit (PSU). Illustrations in power supply module replacement procedures show rear panel views of the enclosure, and PSUs are properly aligned for insertion into the rear panel of the enclosure.

A single PSU is sufficient to maintain operation of the enclosure. You need not halt operations and completely power-off the enclosure when replacing only one PSU; however, a complete orderly shutdown is required if replacing both power supply units.

⚠️ CAUTION: Power supply FRU replacement activities can cause enclosure cables to disconnect and disks to go offline. Be careful with cabling connections during FRU replacement.

If immediate replacement is necessary during I/O, ensure that all cables are securely fastened, and proceed with caution as you replace the power supply FRU within the controller enclosure. Be very careful if moving a cabled/operational enclosure during the FRU replacement process.

💡 TIP: See Table 6 on page 36 for additional information about power supply faults and recommended actions.

Before you begin

⚠️ CAUTION: Removing a power supply unit significantly disrupts the enclosure’s airflow. Do not remove the PSU until you have received the replacement module.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

Verifying component failure

You can observe power supply component health (PSUs, fans) using LEDs, management interfaces, or a combination thereof to verify component failure or component operation (see Using management interfaces on page 55 for more information).

When either a fan or power supply component fails, the SMC or RAIDar provide notification; faults are recorded in the event log; and the PSU’s status LED color changes to amber to indicate a fault condition. Table 6 describes menu navigation using the SMC (v3) or RAIDar (v2). The shorthand v3 and v2 prefixes are used to distinguish between the GUI product versions supported by Ultra56 Series enclosures.
Table 6 also references a CLI command. You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

**Table 6**  Power supply faults and recommended actions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Recommended action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power supply fan warning or failure, or power supply warning or failure</strong>&lt;br&gt;Event code 551</td>
<td>• v3: Verify that all fans are working using the SMC. Click the <strong>System</strong> tab within the topics pane and from the System topic, select the <strong>Rear</strong> tab. Hover over each power supply module to view health attributes. You can also select the <strong>Table</strong> tab and view health status for power supply modules and other components in tabular form.&lt;br&gt;• v2: Verify that all fans are working using RAIDar. In the Configuration View, expand <strong>Physical</strong>, right-click the enclosure and select <strong>View &gt; Overview</strong>. Select either <strong>Rear Graphical</strong> or <strong>Rear Tabular</strong> to view health attributes.&lt;br&gt;• Optionally, you can verify that all fans are working using the CLI. The <strong>show fans</strong> command will output health status for fans in the specified enclosure.&lt;br&gt;• Ensure that the power supply modules are properly seated and secured within their slots.&lt;br&gt;• Ensure that no slots are left open for more than two minutes. If you must replace the FRU, leave the old module in place until the replacement arrives, to maintain optimal airflow and avoid overheating.</td>
</tr>
<tr>
<td><strong>Power supply module failure status, or voltage event notification</strong>&lt;br&gt;Event code 551 or 554</td>
<td>• Verify that the power supply module is powered on. If your power supply module has a power switch, verify that it is switched on.&lt;br&gt;• Verify that the power cables are securely attached to the power supply module and the appropriate power source.&lt;br&gt;• Replace the FRU if necessary.</td>
</tr>
<tr>
<td><strong>AC Power Good LED is off</strong></td>
<td>Same as above.</td>
</tr>
<tr>
<td><strong>Voltage/Fan Fault/Service Required LED is illuminated</strong></td>
<td>Replace the power supply module FRU.</td>
</tr>
</tbody>
</table>

**Power supply units**

The Ultra56 Series enclosures feature two redundant power supplies: either both AC or both DC. AC and DC power supplies are power-cycled using the chassis-mounted power switch located beneath the PSU slot. Power cycling procedures vary according to the type of power supply module included with the enclosure. Power cycling procedures for the Ultra56 Series enclosures are described in this section.
AC and DC PSUs

The AC and DC power supply are shown below as they appear when facing the rear panel of the enclosure. For a midplane-facing view of the PSU, see Figure 1 on page 12.

![AC and DC PSU diagram](image)

**Figure 17** AC and DC PSU

Powering off the PSU

1. Stop all I/O from hosts to the enclosure (see Stopping I/O on page 21).

   ✤ **TIP:** This step is *not* required for hot-swapping; however, it is required when replacing both PSUs.

2. Use management software to shut down any other system components necessary.

   ✤ **TIP:** This step is *not* required for hot-swapping; however, it is required when replacing both PSUs.

3. Turn off the power switch located below the PSU on the chassis, as shown in Figure 17.

   △ **CAUTION:** When the PSU is in the Standby position, there is still power flowing through the unit. Please see the warning labels located on the PSU’s handle (see Figure 19 on page 38) for more information on power supply requirements and safety requirements.

Disconnecting an AC power cord

1. Verify that the power switch on the AC PSU being replaced is in the Standby position.

2. Disconnect the power cord’s male plug from the power source.

3. Disconnect the power cord’s female plug from the power cord connector on the PSU.

   **NOTE:** See Connecting a power cable on page 40 for illustrations showing AC power cord connection/disconnection.

Disconnecting a DC power cable

1. Verify that the power switch on the DC PSU being replaced is in the Standby position.
2. Loosen the cable-locking screws that attach each connector to its power supply, and carefully disconnect the lugs on each cable wire component of the DC power cable from the DC power source.

![DC power cable featuring 2-circuit header and lug connectors (4U)](image)

3. Loosen the cable-locking screws attaching the connector to the PSU, and disconnect the power cable from the PSU.

Removing a power supply unit

1. If replacing a single power supply module via hot-swap, proceed to step 3.
2. If replacing both power supply modules, verify that the enclosure is powered off. Verify that the power switch is set to the **Standby** position.
3. Verify that the power cords are both disconnected.
4. Using your index finger, move the red latch up to disconnect the module from the internal connector. See Figure 19 below.

![Removing a power supply unit](image)

5. Pull the module straight out of the chassis slot, taking care to support the base of the PSU—with both hands—as you remove it from the enclosure.
6. If replacing two power supply modules, repeat steps 3—5.

⚠️ **CAUTION:** Do not lift the module by its plastic protective cover; doing so could damage the cover. Using both hands, lift and carry the module using its metal casing.
Installing a power supply unit

1. Orient the PSU with the power cable connector on the bottom as shown above.
2. With the handle in the open position, ensure that the power supply module is level, and slide it into the appropriate power supply slot as far as it will go.
3. Using your index finger, move the red button up, ensuring that the connector on the PSU engages the connector inside the chassis.
4. If replacing two power supply modules, repeat steps 1—3.
Connecting a power cable

This section addresses power cable connection for enclosures configured with AC and DC power supply modules.

Connecting an AC power cord

Obtain two suitable power cords: one for each AC power supply that will connect to a separate power source. See the figure at right when performing the following steps:

1. Verify that the enclosure’s power switches are in the **Standby** position.
2. Identify the power cord connector on the PSU, and locate the target power source.
3. Using the AC power cords provided, plug one end of the cord into the power cord connector on the PSU. Plug the other end of the power cord into the rack power source.
4. Verify connection of primary power cables from the rack to separate external power sources.

Connecting a DC power cable

1. Locate the appropriate DC power cables.
2. Verify that the enclosure’s power switches are in the **Standby** position.
3. Connect the DC power to each DC power supply using the 2-circuit header connector.
4. Tighten the screws at the base of the connector—left and right sides—applying a torque between 1.7 N-m (15 in-lb) and 2.3 N-m (20 in-lb), to securely attach the cable to the DC power supply module.
5. To complete the DC connection, secure the other end of each cable wire component of the DC power cable to the target DC power source.

Check the two individual DC cable wire labels before connecting each cable wire lug to its power source. One wire is labeled **positive** (+L) and the other is labeled **negative** (-L). The Ultra56 Series enclosure is grounded independently of this DC cable. The chassis ground wire is connected from a dual lug on its mounting rail to the rack in which it is mounted.

⚠️ **CAUTION:** Connecting to a DC power source outside the designated -48VDC nominal range (-36VDC to -72 VDC) may damage the enclosure.
Verifying component operation

Examine PSU module status as indicated in the table below.

![ PSU module LEDs diagram ]

LEDs for a PSU are located in the bottom left corner of the module face, as shown above.

If the Voltage/Fan Fault/Service Required LED is illuminated amber, the PSU module has not gone online, and likely failed its self-test. Remove and reinstall the PSU module. In addition to viewing the PSU LEDs, verify that the cooling fans are spinning. Also see Using management interfaces on page 55 as an alternative to physically observing LEDs to verify component operation.

Replacing a fan control module

This section provides procedures for replacing a failed fan control module (FCM). Illustrations in fan control module replacement procedures show rear panel views of the enclosure, and FCMs are properly aligned for insertion into the rear panel of the enclosure.

A single FCM is sufficient to maintain operation of the enclosure. You need not halt operations and completely power-off the enclosure when replacing only one FCM; however, a complete orderly shutdown is required if replacing both fan control modules.

**TIP:** See Table 8 for additional information about fan module faults and recommended actions.

Before you begin

**CAUTION:** Removing a fan control module significantly disrupts the enclosure’s airflow. Do not remove the FCM until you have received the replacement module.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.
Verifying component failure

You can observe fan module component health (PSUs, fans) using LEDs, management interfaces, or a combination thereof to verify component failure or component operation (see Using management interfaces on page 55 for more information).

When either a fan or power supply component fails, the SMC or RAIDar provide notification; faults are recorded in the event log; and the FCM’s status LED color changes to amber to indicate a fault condition.

Table 8 describes menu navigation using the SMC (v3) or RAIDar (v2). The shorthand v3 and v2 prefixes are used to distinguish between the GUI product versions supported by Ultra56 Series enclosures.

Table 8 also references a CLI command. You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.

Table 8  Fan control module faults and recommended actions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Recommended action</th>
</tr>
</thead>
</table>
| Power supply fan warning or failure, or fan module warning or failure Event code 552 or 558 (4U56) | • v3: Verify that all fans are working using the SMC. Click the System tab within the topics pane and from the System topic, select the Rear tab. Hover over each fan control module to view health attributes. You can also select the Table tab and view health status for fan control modules and other components in tabular form.  
• v2: Verify that all fans are working using RAIDar. In the Configuration View, expand Physical, right-click the enclosure and select View > Overview. Select either Rear Graphical or Rear Tabular to view health attributes.  
• Optionally, you can verify that all fans are working using the CLI. The show fans command will output health status for fans in the specified enclosure.  
• Ensure that the power supply modules are properly seated and secured within their slots.  
• Ensure that the fan control modules are properly seated and secured within their slots.  
• Ensure that no slots are left open for more than two minutes. If you must replace the FRU, leave the old module in place until the replacement arrives, to maintain optimal airflow and avoid overheating. |
| AC Power Good LED is off                                               | Same as above.                                                                     |
| Voltage/Fan Fault/Service Required LED is illuminated                 | Replace the power supply module FRU.                                               |

Removing a fan control module

1. If replacing a single fan control module via hot-swap, proceed to step 3.
2. If replacing both fan control modules, verify that the enclosure is powered off.
3. Verify that the power cord is disconnected.
4. Using your index finger, move the latch (located on the right side of the handle) to the left.

See Figure 23, below.
5. While holding the handle with the latch pinched, pull the module straight out of the chassis slot, taking care to support the base of the FCM—with both hands—as you remove it from the enclosure.
6. If replacing two fan control modules, repeat steps 3—5.

⚠️ **CAUTION:** The fan may continue to rotate after removing the FCM.

### Installing a fan control module

To install a fan control module, perform the following steps:

1. Orient the FCM with the power connector (located on the back of the FCM) on the top right. There is a stop pin to prevent insertion of the FCM in the wrong orientation.
2. With the latch in the open position, ensure that the fan control module is level, and slide it into the appropriate fan control slot as far as it will go. When the FCM has locked into position, you will hear a click from the latch.
3. If replacing two fan control modules, repeat step 1 and step 2.
Verifying component operation

Examine FCM module status as indicated in the table below.

<table>
<thead>
<tr>
<th>LED No./Description</th>
<th>Color</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 — FRU OK</td>
<td>Green</td>
<td>On</td>
<td>Power is on with at least one fan operating normally.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Both fans are off; the system is powered off.</td>
</tr>
<tr>
<td>2 — Fault/Service Required</td>
<td>Amber</td>
<td>On</td>
<td>Fault detected; event has been acknowledged but the problem needs attention.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No fault condition exists.</td>
</tr>
<tr>
<td>3 — Unit locator</td>
<td>White</td>
<td>On</td>
<td>FRU is identified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>Normal operation.</td>
</tr>
</tbody>
</table>

Figure 24 Installing a fan control module

Figure 25 Fan control module LED descriptions
Replacing ear components

Before you begin

⚠️ **CAUTION:** Verify that you have the proper FRU kit (left or right) for the ear components being replaced.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

Enclosure ear kit FRUs are available for the left and right ears of the chassis front panel. The following replacement procedure applies to ear kits provided with the 4U56 enclosure models. Refer to the following illustrations when removing or installing ear kit components. Illustrations in ear kit replacement procedures show front panel views, and ear kit components are properly aligned for attachment to the ears on the front panel of the enclosure.

**Figure 26** shows the left ear of a 4U56 model with the LED circuit board exploded from its installed position on the ear flange. The enclosure bezel is removed to reveal the left ear flange and the left drawer in closed position. See **Figure 3** on page 13 and **Enclosure bezel for 56-drive model** on page 15 for bezel attachment and removal details.

![Left ear with bezel removed](image)

**Figure 26** Replacing left ear components

**Figure 27** shows the right ear of a 4U56 model. The enclosure bezel is removed to reveal the right ear flange and the right drawer in closed position. The LED circuit board is shown exploded from its installed position—and aligned with the light pipe sub-assembly—which is integral to the enclosure bezel.

![Right ear with bezel removed](image)
Figure 27 Replacing right ear components

The enclosure bezel attaches to four ball studs on the front of the enclosure: each 4U56 chassis ear flange hosts two ball studs. Relative to both left and right ear kits, see Removing ear components on page 46 and Installing ear kit components on page 46.

Removing ear components

See Figure 26 on page 45 (4U56 chassis) and Figure 27 on page 46 (4U56 chassis).

1. Stop all I/O from hosts to the system.
2. Use management software to shut down any other components necessary.
3. Power off the enclosure. Take care to remove both power cords.
4. Remove the enclosure bezel:
   See Figure 3 on page 13 and supporting narrative for 4U56 enclosure bezel removal.
5. On the target ear, loosen the two screws securing the LED circuit board to the threaded mounting sleeves protruding from the ear flange. Use a No.2 Phillips screw driver.
   Remove the screws and retain them for use when installing the new LED circuit board.
6. Remove the ESD cage protecting the LED circuit board, and retain it for reinstallation (applies to left ear kit replacement only: see Figure 26 on page 45).
7. Disconnect the flexible ribbon cable from the back of the LED circuit board.
   a. Pull gently on the LED circuit board to stretch the ribbon cable attached to the back of the board.
   b. Reach behind the LED circuit board, and slightly pull outward on the locking mechanism of the connector to release the flexible ribbon cable from the circuit board.
8. Remove the LED circuit board, and label it as damaged or defective to prevent its reuse.
   • Figure 26 on page 45 shows the left ear circuit board and LEDs of 4U56 enclosures.
   • Figure 27 on page 46 shows the right ear circuit board and LEDs of 4U56 enclosures.

Installing ear kit components

Refer to the appropriate target ear illustration when installing ear kit components for your product:

• See Figure 26 on page 45 for left ear kit components on 4U56 enclosures.
• See Figure 27 on page 46 for right ear kit components on 4U56 enclosures.

1. Locate the replacement LED circuit board for the target ear.
2. Verify that the enclosure is powered off. Remove both power cords.
3. Install the LED circuit board for the target ear:
   a. Properly orient the replacement LED circuit board, and align it for installation onto the ear flange as shown in the pertinent illustration (see bullet list above).
b. Release the locking mechanism on the ribbon cable connector, located on the back of the LED circuit board, by pulling out on the locking mechanism.

c. While holding the flexible ribbon cable steady, insert it into the connector on the back of the LED circuit board, and push in on the locking mechanism to secure the cable connection.

d. Locate the ESD cage and align its through-holes with those on the LED circuit board (applies to left ear kit replacement only; see Figure 26 on page 45).

e. Locate the LED circuit board fastener screws that you previously removed, and insert a screw through each of the board’s two mounting holes, and into the threaded hole of the sleeve on the ear flange.

f. Take care to ensure that the screw threads correctly mesh with the threads in the hole—in order to avoid cross-threading or stripping—and hand tighten them. If a calibrated torque driver is available, torque each screw to 3 in./lbs.

g. Verify that the LED circuit board is securely installed and the flexible ribbon cable is fully-seated into the connector, and locked in place.

4. Gently slip the enclosure bezel cover onto the push-fit mounting ball studs, taking care to guide the LED indicators through the bezel’s ear covers.

5. Power on the enclosure.

\[ \text{TIP: See the AssuredSAN Ultra56 Series Setup Guide for descriptions of front panel LEDs.} \]

Verifying component operation

Enclosure status LEDs are located on the front of the controller enclosure. During normal operation, the FRU OK and Temperature Fault LEDs are green, and the other status LEDs located on the right ear are off.

Transceivers used in CNC ports

AssuredSAN 4854 models use Converged Network Controller (CNC) technology, allowing you to select the desired host interface protocol from available Fibre Channel (FC) or Internet SCSI (iSCSI) host interface protocols supported by the system. You can use the CLI to set all controller module CNC ports to use one of these host interface protocols: 16 Gbit/s FC; 8 Gbit/s FC; 10GbE iSCSI; or 1 Gbit/s iSCSI.

Alternatively, you can use the CLI to set CNC ports to support a combination of host interface protocols. When configuring a combination of host interface protocols, host ports 0 and 1 must be set to FC (either both 16 Gbit/s or both 8 Gbit/s), and host ports 2 and 3 must be set to iSCSI (either both 10GbE or both 1 Gbit/s), provided the CNC ports use the qualified SFP connectors and cables required for supporting the selected host interface protocol. CNC ports can be used for host connection or remote replication, provided the optional AssuredRemote™ feature is licensed.

\[ \text{IMPORTANT: To change the host port mode for CNC ports, follow the “Change the host port mode” instructions provided in the AssuredSAN Ultra56 Series Setup Guide.} \]

Replacing a Fibre Channel transceiver

This section provides steps for replacing a small form-factor pluggable (SFP transceiver) connector used in a Fibre Channel controller module host port. An example SFP connector is shown below. It is pictorially
oriented to align for insertion into the CNC port, such that the connector is flush with the IOM face plate on the enclosure rear panel.

![Sample SFP connector](image)

**Figure 28** Sample SFP connector

**NOTE:** See the “4854 controller module — rear panel components” topic within the Setup Guide for an illustration showing an FC SFP installed within the IOM.

### Before you begin

**CAUTION:** Mishandling fibre-optic cables can degrade performance. Do not twist, fold, pinch, or step on fibre-optic cables. Do not bend them tighter than a 2-inch radius.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

**CAUTION:** To prevent potential loss of access to data, be sure to identify the correct cable and SFP connector for subsequent removal.

### Verifying component failure

Transceivers are part of a data path that includes multiple components, such as the transceiver, a cable, another SFP, and an HBA (host bus adapter). A reported fault can be caused by any component in the data path. To identify the location of the fault, check the Link Status/Link Activity LED on the controller module face plate, and check the link status and link activity LEDs on the server. Also, check the cable for kinks, crimping or other possible damage.

**TIP:** See the AssuredSAN Ultra56 Series Setup Guide for descriptions of rear panel LEDs.

### Removing an SFP module

Perform the following procedure to remove an SFP connector. When removing an FC SFP that has previously limited the port speed—and replacing it with a higher-rated SFP—it is possible, though rare, that auto-negotiation will not enable the higher port speed. Rebooting the array or the host resolves the problem.

1. Disconnect the fibre-optic interface cable by squeezing the end of the cable connector.
   
   If the SFP does not have a cable, it should have a plug (retained from installation).
2. SFPs are commonly held in place by a small wire bail actuator. Flip the actuator up.

3. Grasp the SFP between your thumb and index finger, and carefully remove it from the controller module.

Installing an SFP module

Perform the following procedure to install an SFP connector.

1. Locate the SFPs that will be used in the CNC ports.
   • If the SFP has a plug, remove it before sliding the connector into the CNC port. Retain the plug.
   • If using different SFPs in combination, locate the appropriate SFP pertaining to each target CNC port, and note the port number (0 — 3) into which each SFP will install.
   • See the “Configuring host ports” topic in the Storage Management Guide for information about configuring CNC ports for use with qualified FC or iSCSI SFP options.

2. Install the SFP and connect the host interface cable per Figure 31 below:
   a. Flip the SFP actuator and revolve it downwards.
   b. Insert the SFP into the CNC port and ensure that it locks securely into place.
   c. Align the fibre-optic interface cable with the duplex jack at the end of installed SFP.
3. Connect the fibre-optic interface cable to the duplex jack at the end of the SFP connector.
4. Repeat steps 1—3 for each SFP requiring installation into a CNC port.

**TIP:** See the “Configuring host ports” topic in the Storage Management Guide for information about configuring CNC ports for use with FC or iSCSI host ports.

Verifying component operation

View the Link Status/Link Activity LED on the controller module face plate. A blinking LED indicates that no link is detected. Also check the link status and link activity LEDs on the host.

Replacing a 10GbE SFP+ transceiver

This section provides steps for removing and replacing a small form-factor pluggable plus (SFP+) transceiver connector used in an Internet SCSI (iSCSI) controller host port. SFP+ connectors are similar in appearance to SFP connectors. These transceivers enable 10GbE equipment designs with high port density, based on electrical and mechanical enhancements to SFP specifications developed by the Small Form Factor (SFF) Committee.

Removing and replacing an SFP+ consists of the same basic steps described for removing and replacing an SFP in the preceding section. This procedure refers to the preceding Replacing a Fibre Channel transceiver instructions. When reviewing the procedure as it pertains to the 10Gb iSCSI host ports, note that your particular cables may be either copper or fibre-optic for the SFP+, depending upon how your system was initially configured, and the SFP+ option used.

**Table 9** Removing and replacing a 10GbE SFP+ transceiver

<table>
<thead>
<tr>
<th>To accomplish this sequential process</th>
<th>See the following procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b. Verifying component failure on page 48.</td>
</tr>
<tr>
<td></td>
<td>c. Removing an SFP module on page 48.</td>
</tr>
<tr>
<td>2. Install the replacement SFP+ connector.</td>
<td>Installing an SFP module on page 49.</td>
</tr>
<tr>
<td>3. Verify proper operation for the removed and reinstalled component.</td>
<td>Verifying component operation on page 50.</td>
</tr>
</tbody>
</table>

**NOTE:** See the “4854 controller module — rear panel components” topic within the Setup Guide for an illustration showing a 10GbE SFP+ installed within the IOM.

Replacing a 1Gb RJ-45 SFP transceiver

This section provides steps for removing and replacing a small form-factor pluggable transceiver connector used in an Internet SCSI (iSCSI) controller host port. The copper RJ-45 connectors are similar in appearance to other SFP connectors.

Removing and replacing an RJ-45 SFP consists of the same basic steps described for removing and replacing an SFP in the preceding FC and 10GbE iSCSI sections. This procedure refers to Replacing a
Fibre Channel transceiver on page 47. When reviewing the procedure as it pertains to the 1Gb iSCSI host ports, note that this particular SFP does not support an optic option for 1 Gb.

Table 10  Removing and replacing a 1 Gb SFP transceiver

<table>
<thead>
<tr>
<th>To accomplish this sequential process</th>
<th>See the following procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>b. Verifying component failure on page 48.</td>
</tr>
<tr>
<td></td>
<td>c. Removing an SFP module on page 48.</td>
</tr>
<tr>
<td>2. Install the replacement SFP connector.</td>
<td>Installing an SFP module on page 49.</td>
</tr>
<tr>
<td>3. Verify proper operation for the removed and reinstalled component.</td>
<td>Verifying component operation on page 50.</td>
</tr>
</tbody>
</table>

NOTE: See the “4854 controller module — rear panel components” topic within the Setup Guide for an illustration showing an 1 Gb RJ-45 SFP installed within the IOM.

Replacing a storage enclosure chassis

The controller enclosure or expansion enclosure chassis replacement procedure replaces a damaged chassis FRU, which consists of the structural support metal, the exterior sheet metal housing, the assembled-installed midplane, and the drawer assemblies. The procedure includes removing all FRU components from a damaged chassis and installing them into a replacement chassis.

NOTE: Ultra56 Series storage enclosures are described in Storage enclosure overview on page 10.

A fully functional replacement chassis requires the successful removal and installation of the following components:
- Enclosure bezel (covers enclosure front panel)
- All disk drive modules
- Ear components
- Two power supply units of the same type (both AC or both DC)
- Two fan control modules
- One or two I/O modules (of the same model type)

CNC models require the successful removal and installation of qualified SFP options. This procedure makes extensive use of the FRU component procedures described elsewhere in Chapter 2.

Before you begin

⚠️ CAUTION: Do not remove the enclosure until you have received the replacement enclosure.

See the CAUTION bullets regarding “electrostatic discharge” and “anti-static protection” on page 17.

1. Schedule down time that will allow for shutdown; sixty minutes of replacement work; and restart.
2. Verify the existence of a known/good backup of the system.
3. Record system settings for future use and label all cables.
4. Prepare a suitable static-protected work environment to accommodate chassis replacement.
Verifying component failure

The controller enclosure FRU includes the enclosure’s metal housing and the midplane that connects I/O modules, power supply modules, and the igus chain-flex subassemblies for communicating with PCBAs installed in the drawers (disks are installed separately). This chassis FRU replaces an enclosure that has been damaged, or whose midplane has been damaged. Often, a damaged midplane will appear as though an I/O module has failed. If you replace an IOM, and it does not remedy the fault, you may need to replace the enclosure.

You can observe enclosure health (front panel and rear panel) using management interfaces to verify enclosure/component failure or enclosure/component operation (see Using management interfaces on page 55 for more information).

Preparing to remove a damaged storage enclosure chassis

Because you are removing and replacing an entire storage enclosure, neither the hot-swap capability that applies to replacing individual redundant FRUs in an operational storage enclosure, nor the hot-add of a drive enclosure to an operational storage system, apply to this procedure.

1. Stop all I/O from hosts to the system. See Stopping I/O on page 21.
2. Shut down the controllers. See Shutting down a controller module on page 22.
3. Power off the system (controller enclosure first; expansion enclosures next). See Power supply units on page 36.

Table 11  Removing and replacing a storage enclosure chassis and its FRUs

<table>
<thead>
<tr>
<th>To accomplish this sequential process</th>
<th>See the following procedures</th>
</tr>
</thead>
</table>
| 1. Remove the enclosure bezel to provide access to front panel components. | a. Figure 3 on page 13 (4U56 chassis)  
  b. See the supporting narrative following Figure 3. |
| 2. Remove the ear components from the damaged chassis. | a. Before you begin on page 45.  
  b. Removing ear components on page 46. |
| 3. Remove the disk drive modules from the two drawers. | Removing a disk drive module on page 31 |
| 4. Remove the damaged storage enclosure chassis from the rack. | Removing a damaged storage enclosure chassis from the rack on page 53. |
| 5. Remove the power supply units from the damaged chassis, and install them in the replacement chassis. | a. Before you begin on page 35.  
  b. Power supply units on page 36.  
  c. Removing a power supply unit on page 38.  
  d. Installing a power supply unit on page 39. |
| 6. Remove the fan control modules from the damaged chassis, and install them in the replacement chassis. | a. Before you begin on page 41  
  b. Removing a fan control module on page 42  
  c. Installing a fan control module on page 43 |
| 7. Remove each IOM from the damaged chassis, and install it in the replacement chassis. | a. Before you begin on page 20.  
  b. Removing a controller module or expansion module on page 24.  
  c. Installing a controller module or expansion module on page 25. |
| 8. Remove each FC SFP from the damaged chassis, and install it in the replacement chassis (Fibre Channel models only). | a. Before you begin on page 48.  
  b. Removing an SFP module on page 48.  
  c. Installing an SFP module on page 49. |
| 9. Remove each 10GbE SFP from the damaged chassis, and install it in the replacement chassis (10GbE iSCSI models only). | Replacing a 10GbE SFP+ transceiver on page 50.  
  Also see Steps 7a — 7c immediately above. |
Table 11  Removing and replacing a storage enclosure chassis and its FRUs (continued)

<table>
<thead>
<tr>
<th>To accomplish this sequential process</th>
<th>See the following procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. Remove each 1 Gb SFP from the damaged chassis, and install it in the replacement chassis (1 Gb iSCSI models only).³</td>
<td>Replacing a 1Gb RJ-45 SFP transceiver on page 50. Also see Steps 7a — 7c above.</td>
</tr>
<tr>
<td>11. Install ear kit components on the replacement chassis.</td>
<td>Installing ear kit components on page 46.</td>
</tr>
<tr>
<td>12. Install the replacement storage enclosure chassis in the rack.</td>
<td>Installing the replacement storage enclosure in the rack on page 54.</td>
</tr>
<tr>
<td>13. Install disks in the drawers.¹</td>
<td>Replacing a disk drive module on page 30 and FDE considerations on page 30.</td>
</tr>
</tbody>
</table>
| 15. Verify proper operation for all removed and installed FRU components. | b. Completing the process on page 54.  
|                                              | b. Disks—Verifying component operation on page 34.  
|                                              | c. IOMs—Verifying component operation on page 26.  
|                                              | d. PSUs—Verifying component operation on page 41.  
|                                              | e. FCMs—Verifying component operation on page 44  
|                                              | f. SFPs (if applicable)—Verifying component operation on page 50.  
|                                              | g. Verify PFU enabled (if applicable)—Configuring partner firmware update on page 20. |

¹Within the replacement enclosure, reinstall each disk into the same slot from which it was extracted from the damaged enclosure.

²Within the replacement enclosure, the IOM(s) must be reinstalled into the same IOM slots from which they were extracted from the damaged enclosure.

³If your enclosure model does not use CNC ports, ignore this step.

⁴In order to reduce the weight of the chassis, FRUs can be removed before removing and replacing the chassis.

Removing a damaged storage enclosure chassis from the rack

This section provides a procedure for removing a damaged storage enclosure chassis from its rack location.

⚠️ CAUTION: It is recommended that all enclosure disks be removed before removing the enclosure. At least two people are required to move the enclosure.

1. Make sure the ear components are removed. See Removing ear components on page 46.
2. Remove the retaining screws that secure the front and rear of the enclosure chassis to the rack and rails.
3. Maintaining a level position, carefully slide the enclosure chassis from the rack.
4. Place the chassis on a work surface near the replacement enclosure chassis, the removed disk drive modules, ear components, and screws.
5. Remove the side bracket from each side of the damaged enclosure chassis, and retain these rackmount items with the other components for future use.
Installing the replacement storage enclosure in the rack

This section provides a procedure for installing the replacement enclosure in its rack location.

⚠️ CAUTION: It is recommended that all enclosure disks be removed before lifting the enclosure. At least two people are required to move the enclosure.

NOTE: Refer to Rackmount Bracket Kit Installation used with your product for the correct procedure and mounting hardware.

1. Attach side brackets on the replacement enclosure chassis.
2. Support the bottom of the enclosure chassis. Carefully lift/align the chassis and while maintaining a level position for the enclosure, slide it into the rack.
3. Using the appropriate mounting hardware, secure the enclosure chassis to the rack.
4. Install the ear components. See Installing ear kit components on page 46.
5. Using the applicable retaining screws, secure the front and rear or the enclosure chassis to the rack and rails.
6. Attach the enclosure bezel to the front panel of the enclosure:
   See Figure 3 on page 13 and Enclosure bezel for 56-drive model on page 15 for bezel attachment and removal details.

Completing the process

This section provides a procedure for ensuring that the FRU components installed in the replacement controller enclosure chassis function properly.

1. Reconnect data cables between devices, as needed, to return to the original cabling configuration:
   • Between cascaded enclosures.
   • Between the controller and peripheral or SAN devices.
   • Between the controller enclosure and the host.
2. Reconnect power cables to the controller enclosure. See Connecting a power cable on page 40.
3. Turn on the power switch for each power supply module.

Verifying component operation

1. Restart system devices in the following sequence. Allow time for each device to complete its Power On Self Tests (POST) before proceeding:
   a. Expansion enclosure(s)
   b. Controller enclosure
   c. Host (if powered down for maintenance)
2. Perform a rescan to force a fresh discovery of all expansion enclosures connected to the controller enclosure. This step clears the internal SAS layout information, reassigns enclosure IDs, and ensures the enclosures are displayed in the proper order. Use the CLI, the SMC, or RAIDar to perform the rescan:
   To perform a rescan using the CLI, enter the following command:
   ```bash
   rescan
   ```
   You can set a CLI preference to use v3 or v2 terminology in command output and system messages. See the TIP bullets regarding CLI “default management mode” and “current management mode” page 21.
   To rescan using the SMC (v3):
   a. Verify that both controllers are operating normally.
   b. Do one of the following:
      • Point to the System tab and select Rescan Disk Channels.
• In the System topic, select Action > Rescan Disk Channels.

c. Click Rescan.

To rescan using RAIDar (v2):

a. Verify that the controllers are operating normally.
b. In the Configuration View panel, right-click the system and select Tools > Rescan Disk Channels.
c. Click Rescan.

See “Correcting enclosure IDs” in the Setup Guide for additional information.

Using LEDs

View LEDs on the front and rear of the enclosure (see “LED descriptions” within the AssuredSAN Ultra56 Series Setup Guide for more information).

Verify front panel LEDs:

• Verify that the Enclosure ID LED (located on the left ear) is illuminated green.
• Verify that the FRU OK and Temperature Fault LEDs are illuminated green, and that the Fault/Service Required LED is off (all three LEDs are located on the right ear).
• Verify that the drawer OK LED is illuminated green (top LED located on drawer front panel).
• For SFF disks, verify that the Power/Activity LED (single bi-color LED on front of disk) is illuminated green or blinking green.

Remove the enclosure bezel and open the target drawer to view disk LEDs. Close the drawer and re-attach the bezel when finished viewing disk LEDs.

Verify rear panel LEDs:

• Verify that each power supply module’s Input Source Power Good LED (top LED on PSU) is illuminated green.
• Verify that the FRU OK LED on each fan control module is illuminated green, indicating that the module power is on with at least one fan operating normally.
• Verify that the FRU OK LED on each IOM face plate is illuminated green, indicating that the module has completed initializing, and is online.

Using management interfaces

In addition to viewing LEDs as described above, you can use management interfaces to monitor the health status of the system and its components, provided you have configured and provisioned the system, and enabled event notification (see “Getting Started” within the AssuredSAN Ultra56 Series Storage Management Guide for more information).

Select from the following methods to verify component operation:

• Use the SMC (v3) or RAIDar (v2) to check the health icons/values of the system and its components to either ensure that everything is okay, or to drill down to a problem component. The SMC and RAIDar use health icons to show OK, Degraded, Fault, or Unknown status for the system and its components. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
• As an alternative to using the SMC or RAIDar, you can run the show system command in the CLI to view the health of the system and its components. If any component has a problem, the system health will be Degraded, Fault, or Unknown. If you discover a problem component, follow the actions in its Health Recommendations field to resolve the problem.
• Monitor event notification — With event notification configured and enabled, you can view event logs to monitor the health of the system and its components. If a message tells you to check whether an event has been logged, or to view information about an event in the log, you can do so using the SMC, RAIDar, or the CLI. Using either the SMC or RAIDar, you would view the event log and then hover over the event message to see detail about that event. Using the CLI, you would run the show events detail command (with additional parameters to filter the output) to see the detail for an event (see “Alphabetical list of commands > show events” within the AssuredSAN Ultra56 Series CLI Reference Guide for more information about command syntax and parameters).
A Drawer description

This appendix provides reference information complementing the information provided in the FRUs chapter and in the procedure entitled Accessing a drawer on page 28.

Drawer configuration

To gain access to the 4U56 enclosure drawers, you must first remove the enclosure bezel as described in Figure 3 on page 13. To see the contents of a drawer, flip the handle downwards, and pull the drawer outward from the enclosure drawer bay as described in Opening and closing a drawer on page 28.

Drawer pictorials are provided for the two enclosure drawers in Figure 32. Each drawer contains four disk bays, and each disk bay can accommodate seven disks.

Figure 32 Enclosure front face pictorial featuring drawers

Diagrams of the two drawer front panels with corresponding revolved side views showing disk slot numbering are provided in Figure 33. Drawers 0 and 1 provide access to disk bays on the top of the drawer.

Figure 33 Schematic representation of drawers
Loading requirements

See Installing a disk drive module on page 32 for instructions about installing a sledded disk into a slot within a bay in the enclosure drawer. Be mindful of these drawer loading requirements.

- Install your sledded disks into the drawer slots in multiples of seven disk drive modules.
  For example, in disk bay 3 of Drawer 0, install disk modules into slots 21—27 before populating disk bay 2, followed by disk bay 1, and disk bay 0.

**IMPORTANT:** Drawer and disk slot numbering are described pictorially on the adhesive label laminated to the exterior wall of each drawer. Refer to the label when installing disks.

**IMPORTANT:** As you install multiple disks into the drawer, populate from back row to front row, while installing disks into the slots. Slide the drawer in as each row is populated. Provide adequate support for the weight of the extended drawer as you install the disks.

An exception to this statement occurs if you are installing disk modules to partially fill a drawer, in which case you must install a minimum of 14 disk modules, and they must be placed in contiguous slots closest to the front of the drawer.

- Drawers use self-encrypting disk (SED) drives (see FDE considerations on page 30).

LED descriptions for drawer components

**Drawer front panel LEDs**

In Figure 34 below, the enclosure bezel has been removed, and the ears have been cropped to show only the front panels of the three disk drawers. The disk drawers are shown with pull-handles in stowed position. To open a drawer, first loosen the thumb wheel and then rotate the pull-handle upwards by 90° as shown in Figure 33 on page 56. Each drawer front panel features a set of LEDs describing system behavior at the drawer-status level.

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enclosure ear LEDs</td>
<td>Enclosure ear LEDs (see Figure 27 on page 46).</td>
</tr>
</tbody>
</table>
| 2   | Unit Locator | White blink — Enclosure is identified  
Off — Normal operation |
### Disk LEDs

In Figure 35 on page 59, an individual disk drive module is shown and its LED behavior is summarized. To view the disk module LEDs, you must first open the drawer containing the disks you wish to view (see Opening and closing a drawer on page 28). Disk drive slot numbering is provided on the label affixed to the exterior of each drawer.

Alternatively, you can use the SMC or RAIDar to check the health icons/values for the system and its components to ensure that everything is okay, or to drill down to a problem component. If you discover a problem, the SMC, RAIDar, and the CLI provide recommended-action text online.
Electromagnetic interference protection for disks is provided by the EMI shield in the enclosure bezel.

### LED Mode Description

<table>
<thead>
<tr>
<th>LED Mode Description</th>
<th>Color</th>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1—Power/Activity</td>
<td>Green</td>
<td>On</td>
<td>The disk drive is operating normally.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blink</td>
<td>The disk drive module is initializing; active and processing I/O; performing a media scan; or the vdisk or disk group is initializing or reconstructing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>No identify or remove requests are active. If not illuminated and Fault is not illuminated, the disk is not powered on.</td>
</tr>
<tr>
<td>2—Fault</td>
<td>Amber</td>
<td>On</td>
<td>The disk has failed; experienced a fault; is a leftover; or the disk group that it is associated with is down or critical.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blink</td>
<td>Physically identifies the disk; or locates a leftover (also see Blue).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off</td>
<td>If not illuminated and Power/Activity is not illuminated, the disk is not powered on.</td>
</tr>
<tr>
<td></td>
<td>Blue</td>
<td>Blink</td>
<td>Leftover disk from disk group is located (alters blinking amber).</td>
</tr>
</tbody>
</table>

**Figure 35** LED: 4U56 disk drive module
replacing a 1 Gb RJ-45 SFP 50
replacing a 10GbE SFP+ 50
replacing a controller or expansion module 19
replacing a disk drive module 30
replacing a Fibre Channel SFP 47
replacing a PSU 35, 41
replacing a storage enclosure chassis 51
components (common) 51
components (model-specific) 51
damaged chassis removal 53
replacement chassis installation 54
replacing ear components 45

R
related documentation 8

S
SFP transceiver
Fibre Channel controller host port 47
fibre-optic cable 48
small form-factor pluggable 47
SFP+ transceiver
1 Gb iSCSI controller host port 50
10GbE iSCSI controller host port 50
small form-factor pluggable plus 50

U
Ultra56 Series
enclosures (4U56) 7
product overview table 10